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WHERE ARE THE LESSON FILES?
Purchase of this Classroom in a Book in any format gives you access to the lesson files you’ll 
need to complete the exercises in the book.

1 Go to peachpit.com/PhotoshopCIB2024.

2 Sign in or create a new account.

3 Click Submit.

4 Answer the questions as proof of purchase.

5 The lesson files can be accessed through the Registered Products tab on your Account page.

6 Click the Access Bonus Content link below the title of your product to proceed to the 
download page. Click the lesson file links to download them to your computer.

•Note: If you encounter problems registering your product or accessing the lesson files or web 
edition, go to peachpit.com/support for assistance.

•Note: If you purchased a digital product directly from peachpit.com, your product will already be 
registered. Look for the Access Bonus Content link on the Registered Products tab in your account.

http://peachpit.com/PhotoshopCIB2024
http://peachpit.com/support
http://peachpit.com
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EXPLORING NEURAL FILTERS

Lesson overview
In this lesson, you’ll learn how to do the following: 

• Understand how Neural Filters are different than other filters and 
effects in Photoshop.

• Explore the Neural Filters workspace.

• Apply a Neural Filter to an image.

• Combine multiple Neural Filters in a single layer or document. 

This lesson will take about 30 minutes to complete. To get the lesson files 
used in this chapter, download them from the web page for this book at 
peachpit.com/PhotoshopCIB2024. For more information, see “Accessing 
the lesson files and Web Edition” in the Getting Started section at the 
beginning of this book.

As you work on this lesson, you’ll preserve the start files. If you need 
to restore the start files, download them from your Account page.

15

http://peachpit.com/PhotoshopCIB2024
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Neural Filters are advanced fi lters trained using 
machine learning. You can explore ideas that would 
be more labor-intensive, or sometimes impossible, 
with conventional digital photo fi lters and eff ects.

PROJECT: COMPOSITING WITH NEURAL FILTERSPROJECT: COMPOSITING WITH NEURAL FILTERS Landscape: © Jurik Peter, Shutterstock; superhero: © sunlight19, Shutterstock



384 LESSON 15 Exploring Neural Filters

Understanding Neural Filters
If you worked through the earlier lessons in this book, you’ve used Photoshop filters 
such as Surface Blur, Smart Sharpen, Clouds, and Liquify. Those are conventional 
filters that produce their results with algorithms—procedural programs where the 
code itself determines the result.

The newer Neural Filters produce results in a different way, combining traditional 
algorithms with machine learning and other advanced techniques. Machine learning 
means that a filter in Neural Filters can be trained using many examples of desir-
able and undesirable results, potentially creating better images than what could be 
achieved with procedural computer code alone.

Neural Filters are different from other Photoshop effects in the following ways:

• Neural Filters are trained using machine learning techniques.

• Some filters need to be downloaded before the first time you use them. This is 
partly to save space on your computer, because some Neural Filters and their 
machine-learning models can be large. If you need to download a Neural Filter, 
you can do it with one click in the Neural Filters workspace.

• Some filters display a message saying that they process image data in the cloud 
(on Adobe Creative Cloud servers). They may need more power than a desktop 
computer has, or a machine-learning model may be too large to download.

It’s possible to use some Neural Filters without an Internet connection, but you get 
the most options when your computer is connected to the Internet.

Getting started
Neural Filters offer many possibilities to explore. Let’s first take a look at the files 
you’ll work with.

1 Start Photoshop, and then simultaneously hold down Ctrl+Alt+Shift (Windows) 
or Command+Option+Shift (macOS) to restore the default preferences. (See 
“Restoring default preferences” on page 5.)

2 When prompted, click Yes to delete the Adobe Photoshop Settings file.

3 Choose File > Browse In Bridge to open Adobe Bridge.

4 In Bridge, click Lessons in the Favorites panel. Double-click the Lesson15 folder 
in the Content panel. 

5 Compare the files 15Restore.psd and 15Restore_End.psd, 15Colorize.psd and 
15Colorize_End.psd, and 15Composite.psd and 15Composite_End.psd. Using 
Neural Filters, you’ll create the finished files in just a few clicks.

•Note: You can use 
Neural Filters if your 
computer meets the 
system requirements 
for Photoshop, but 
performance is better 
with a more powerful 
CPU, more powerful 
graphics hardware, and 
in some cases a faster 
Internet connection.

•Note: If Bridge 
isn’t installed, the 
File > Browse In Bridge 
command in Photoshop 
will start the Creative 
Cloud desktop app, 
which will download 
and install Bridge. After 
installation completes, 
you can start Bridge. 
For more information, 
see page 3.
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Exploring the Neural Filters workspace
1 In Bridge, double-click the 15Restore.psd file to open it in Photoshop. If the 

Embedded Profile Mismatch dialog box appears, click OK.

2 Save the document as 15Restore_Working.psd in the Lesson15 folder.

3 Choose Filter > Neural Filters.

In the Neural Filters workspace, the image appears in a large preview area on the 
left, and the Neural Filters panel is on the right:

• When you select a filter, its options appear in the Neural Filters panel.

• To use a filter, it must be enabled. A filter is enabled when its toggle switch is 
moved to the right position and in color. You can enable multiple filters.

• If the selected filter recognizes faces in the image, they’re listed in the thumbnail 
preview menu at the top of the options. In the document, a blue rectangle 
indicates the selected face; gray rectangles indicate other detected faces. Select a 
face in the face menu or in the document.

• To compare the current filter results with the original image, click the Show 
Original icon at the bottom of the workspace to select it and display the original 
layer. Click again to deselect it and preview the filter results again. 

• When a document has multiple layers, the Layer Preview button controls 
whether the preview displays one layer or the entire document.

• Along the left side, the top two tools let you paint a mask to hide filter effects 
from some areas, similar to the layer masks you edited in Lessons 6 and 8.

B
C

D E

K L M

F G H

I

J

A

•Note: If Photoshop 
displays a dialog box 
telling you about the 
difference between 
saving to Cloud 
Documents and 
On Your Computer, click 
Save On Your Computer. 
You can also select 
Don’t Show Again, 
but that setting will 
deselect after you reset 
Photoshop preferences.

•Note: If the Neural 
Filters command is not 
available, make sure a 
visible layer is selected.

A.  Add To Selection and Subtract From 
Selection tools

B. Hand tool

C. Zoom tool

D. Selected face

E. Filter lists

F. Filter toggle, enabled

G. Use Graphics Processor (GPU) option

H.  Thumbnail menu for selecting a 
detected subject, such as a face

I. Reset filter options to default settings

J. Options for the selected Neural Filter

K.  Show Original/Preview Changes 
button

L.  Show current layer or all layers  
(Layer Preview)

M. Output options
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Restoring an antique portrait photo
To learn more about Neural Filters, let’s see how they can help restore old photos.

1 In the filters list, scroll down to the Restoration category, and click the toggle 
switch next to the Photo Restoration filter to enable and apply it. (If options are 
not available and a Download button appears instead, click the Download button 
because it means the filter is not yet installed. When the download completes, 
the filter will install itself and be ready for you to use.)

A

B

C

2 To compare the changes with the original, click the Show Original button at the 
bottom of the workspace. Click once to hide the changes and see the original, 
and click again to preview the changes again. If you don’t notice a change, zoom 
in to 100% or higher magnification.

3 As needed, adjust the first two Photo Restoration options, and then repeat step 2 
to check your work:

• We left Photo Enhancement at its default value of 50.

• We reduced Enhance Face to 15 to preserve more of the original film texture.

4 Scroll up or zoom out as needed until you can see the top of the image. That part 
of the photo print is scratched and torn.

•Note: Adobe 
may update Neural 
Filters after this book 
is published, so the 
list of categories and 
filters you see may 
depend on the version 
of Photoshop you are 
using. Also, if Adobe 
updates how Neural 
Filters effects are 
trained, you may see 
different results than 
those in this lesson.

A. Photo Enhancement

B. Enhance Face

C. Scratch Reduction

•Note: Some 
Neural Filters may be 
labeled Beta, which 
means they function 
but are still under 
development. You can 
use them, but when 
the finished version is 
released, those filters 
may produce different 
results or some options 
may be different.
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5 Adjust Scratch Reduction to about 20. A progress bar at the bottom of the 
image may indicate that it will take a little while. When it’s done, the scratch is 
intelligently removed, which you can verify using the Show Original button.

6 You greatly improved this image using the Restoration Neural Filter. For Output, 
choose Smart Filter, and then click OK to exit Neural Filters. Close the document, 
saving your changes.

Adding color and depth blur
You can use Neural Filters to colorize black-and-white images and add depth blur.

1 In Bridge, double-click the 15Colorize.psd file to open it in Photoshop. If the 
Embedded Profile Mismatch dialog box appears, click OK.

2 Save the document as 15Colorize_Working.psd in the Lesson15 folder.

3 Choose Filter > Neural Filters.

4 In the filters list, scroll down to the Color category, and click the toggle switch 
next to the Colorize filter to enable it. Make sure Auto Color Image is selected.

The Colorize filter applies assumed colors to objects and regions it recognizes, such 
as the leaves on the tree and the boy’s skin and clothing. If you disagree with a color 
choice Colorize made (for example, if the shirt is not all the same color), you can 
apply custom colors to specific areas.

▶Tip: If you increase 
the value of a Neural 
Filter option, watch 
out for negative 
side effects on some 
parts of the image. 
It’s typically better to 
leave minor spots and 
wrinkles, cleaning them 
up quickly using the 
retouching techniques 
you learned in Lesson 2.

•Note:  If the Colorize 
options aren’t available 
because the filter needs 
to be downloaded, 
download it.

▶Tip: For a different 
look, expand the 
Adjustments section 
in Colorize and select 
a Profile. If the result 
is too strong, reduce 
the Profile Strength, 
and make any other 
changes you like using 
the other Adjustments 
options.
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5 In the preview image on the right, click to add a new color focal point over an 
area you want to change, and set its color using the color picker below the image. 
Repeat for other areas where you want to change the color.

6 In the Photography category in the filters list, click the toggle switch next to the 
Depth Blur filter to enable it (download it if needed).

7 Adjust filter options as needed until you like the result. We disabled the Focus 
Subject option because it included part of the tree, and we set our Focal Range 
to 40 so that more of the bicycle remains in focus.

8 You’ve brought this image back to life! For Output, choose Smart Filter, and then 
click OK to exit Neural Filters. Close the document, saving your changes.

▶Tip: If the results 
of the Colorize filter 
aren’t perfect, you can 
combine it with manual 
Photoshop techniques. 
For example, after 
closing Neural Filters, 
add a new layer that 
uses the Color blending 
mode, and paint on that 
layer to colorize the 
image under it.
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About Output options 
in Neural Filters
A Neural Filter may provide several options for applying fi lter results to the docu-
ment, in the Output menu. The number of options you see may be diff erent than 
in the fi gure below, depending on which fi lter and fi lter options are selected. Your 
choice aff ects the amount of editing fl exibility you have later.

Current Layer applies the result to the selected layer. This permanently alters the 
original layer. The only way to back out of it is to undo it before you close and save 
the document. We recommend using one of the following options instead, because 
they leave the current layer intact.

New Layer applies the result to a full copy of the selected layer, leaving that original 
unchanged.

New Layer Masked applies the result to a copy of the selected layer with the 
changed areas showing through a layer mask. This helps ensure that areas of the 
image that were not supposed to be changed remain as they are on the original layer.

Smart Filter applies the result to a Smart Object created from the selected layer. 
You can edit the fi lter settings later by double-clicking that layer’s Neural Filters 
instance in the Layers panel.

New Document applies the result to a duplicate document containing the fi lter 
results on one layer.

The choice you make can depend on the balance you want between fl exibility and 
fi le size. Additional layers and Smart Objects provide more editing freedom, but 
tend to create larger fi le sizes.

When you make multiple edits within a fi lter, such as changing multiple faces dif-
ferently in a group portrait, all changes are included in the output. For example, if 
you apply Smart Portrait and Style Transfer to the same layer, all of those results are 
applied to a single layer or Smart Filter.

Neural Filters might not produce perfect results right away. By applying Neural 
Filters results as a separate masked layer, you can freely blend them with the original 
layer to achieve a more convincing result, while still saving many steps compared to 
traditional, more labor-intensive methods.
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Creating a more convincing composite
When compositing multiple images, the images may not be consistent in tone and 
color. Some Neural Filters can help resolve this.

1 In Bridge, double-click the 15Composite.psd to open it in Photoshop. If the 
Embedded Profi le Mismatch dialog box appears, click OK.

2 Save the document as 15Composite_Working.psd in the Lesson15 folder. 
Click OK in the Photoshop Format Options dialog. Th is image will become a 
thumbnail image for a video, but the color palette and subject need to be closer 
to the look of the art director’s concept. 

3 In the Layers panel, make sure the Planet layer is selected, and then choose 
Filter > Neural Filters.

4 In the fi lters list, scroll down to the Creative category, and click to enable the 
toggle switch next to the Landscape Mixer fi lter (if needed, download it fi rst). 
Th e Landscape Mixer fi lter can apply the look of one landscape image to 
another. Depending on the landscape images you mix, you can even change a 
scene from summer to winter or fi ll a desert image with green foliage.

5 In the Landscape Mixer options, click diff erent Presets to experiment with how 
each of them alters the landscape attributes of the layer.

6 Click the fourth preset. Th at’s the one to use for this project.

7 For Output, choose Smart Filter, and then click OK to apply the changes.

8 In the Layers panel, click the eye icon for the Heroine layer to make it visible. Its 
tone and color doesn’t quite match up with the landscape, so let’s improve that.

▶ Tip: You can use 
your own image to 
drive the style applied 
by Landscape Mixer. 
Click Custom, click 
Select An Image, and 
open an image from 
your computer. Also, 
Landscape Mixer 
options let you adjust 
attributes such as the 
amount of Day or Night 
and the time of year. For 
example, you can add 
snow by increasing the 
Winter value.



ADOBE PHOTOSHOP CLASSROOM IN A BOOK 2024 RELEASE 391

9 With the Heroine layer selected, choose Filter > Neural Filters, and in the 
Color category in the fi lters list, click to enable the toggle switch next to the 
Harmonization fi lter (if needed, download it fi rst). Th e Harmonization fi lter 
helps match the color and tone of a layer to another layer in the document.

10 In the Reference Image section, click Select A Layer, and select Planet.

Th e color and tone of the Heroine layer change to better match the color and light 
of the Planet layer, but it could be improved.

11 In the Harmonization options, drag the Cyan/Red slider about halfway toward 
Red, drag Saturation to about +15, and reduce Brightness to about –30. Make 
any other adjustments that make the composite more convincing. Remember to 
use the Show Original button to check your work.

12 For Output, choose Smart Filter, and then click OK to apply the changes.

▶ Tip: The best thing 
you can do to make 
your composite images 
the most convincing 
is to make sure all of 
your original images are 
consistent in as many 
ways as possible—not 
only color and tone, but 
other visual details such 
as the quality of lighting 
(including sources, 
angles, and shadows), 
lens focal length, and 
camera distance from 
the ground.
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13 In the Layers panel, click the eye icon for the Guardian type layer to make it visible.

You’ve completed the video thumbnail …nice work! You used Neural Filters to 
transform the look of both images in just a few steps, making them work together to 
match the mood and the look of the production.

14 Save your work, and close the document.

You’ve learned the basics of using Neural Filters. Th e results created in this lesson 
required only a few steps each; for example, retouching the old images was almost 
no work compared to the steps you learned in Lesson 2 and Lesson 5.

You’re ready to explore the possibilities of the Neural Filters with your own images!

▶ Tip: Neural Filters 
results might not 
always produce perfect 
results right away. But 
remember that you 
can output the results 
to a separate masked 
layer, so you can blend 
them with the original 
layer to achieve a more 
convincing result, 
still saving many 
steps compared to 
more labor-intensive 
methods.
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Finding the filter or effect you want
It can be a challenge to find the right filter or effect, because Photoshop offers 
them in multiple places in the workspace and menus, and some filters are similar to 
others. Here is a quick guide to the places to find filters and effects in Photoshop:

General filters are on the Filter menu and its submenus. Not every filter is visible on 
the submenus, so also remember to look inside the next two filter galleries.

Filter Gallery (Filter > Filter Gallery) offers many conventional (algorithmic) filters, 
such as Diffuse Glow and Mosaic Tiles. These are mostly intended for creative effects.

Neural Filters (Filter > Neural Filters) offer filters trained by machine learning. They 
can produce results that are better than, or not possible with, conventional filters.

To explore all your options, keep those multiple filter locations in mind. For example, 
if you want to improve skin complexion, you can use the more traditional multistep 
technique in Lesson 12 that uses the Surface Blur filter, compare that to the results 
you get from using the one-step Skin Smoothing filter in Neural Filters, and choose 
the result you think is better for a specific image.

Layer styles are nondestructive, easy ways to apply drop shadows, glows, and other 
effects you have tried in this book. You can find them by clicking the fx button at the 
bottom of the Layers panel or on the Layer > Layer Style submenu.

As you have practiced in this book, even a destructive filter (permanently altering 
layer pixels) can be applied nondestructively (allowing edits or removal later) if 
the layer is a Smart Object. You can prepare a selected layer for nondestructive filter-
ing by first choosing Filter > Convert For Smart Filters.

To combine filters on a layer, you can typically apply each filter in turn. In a filter gal-
lery dialog box or workspace (Filter Gallery, Neural Filters, and Blur Gallery), you can 
combine multiple filters before you exit the dialog box or workspace.
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 Neural Filters gallery
In addition to the Neural Filters you try in the lesson, this gallery shows examples of other Neural Filters included 
with Photoshop. Some are useful for restoring and correcting images; others are fun ways to explore creatively. 
Adobe may update or change the available Neural Filters, so the exact list of Neural Filters in Photoshop may 
depend on the version installed on your computer.

Smart Portrait lets you tune details of portraits 
such as emotions, facial expressions, facial age, and 
gestures such as which way the eyes are looking. In 
this example, the head was turned slightly forward.

Super Zoom is a convenient way to enlarge part of 
a photo to use as a portrait. For example, you can 
pick out one person in a group photo and create an 
enhanced, sharpened enlargement for a profi le pic-
ture. Or, if a person’s face is too small in the middle 
of a smartphone photo, you can fi ll more of the 
frame with their face. Unlike many scaling methods, 
Super Zoom off ers detail enhancement, noise reduc-
tion, and JPEG artifact removal powered by machine 
learning. Super Zoom is optimized for portraits, but 
you can try it with other types of subjects.

Skin Smoothing can reduce acne, blemishes, and 
other skin irregularities, while preserving the overall 
character of the skin and maintaining the sharpness 
of facial features such as eyes.

Before. Before.After.

Super Zoom, 3x.

After.

Image © mangostock. Shutterstock
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JPEG Artifacts Removal helps reduce unsightly 
side eff ects produced by applying JPEG image 
compression at a low quality setting. JPEG artifacts 
are typically seen as banding or blocks in areas that 
should be smooth. Although it’s always better to 
use the highest quality version of an image, JPEG 
Artifacts Removal might save the day when a low-
quality JPEG image is all that’s available to you.

Style Transfer lets you apply the artistic style of 
one image to another image. You can choose from 
a range of Artist Styles presets and then customize 
the look further using the fi lter’s options.  You can 
even apply your own style by clicking the Custom 
tab and selecting an image from your computer.

Before.

Before. After.

After.
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Improving Photoshop with 
your usage data and images
An important way that software developers improve features based on machine 
learning is to train them using examples of good results and bad results. Any com-
pany that uses machine learning needs a way to train the models that their software 
uses, ideally using examples that represent the interests of the customers of the 
software. But many software developers don’t have very large data sets of actual 
customer fi les, and even if they store customer fi les in the cloud, they typically do 
not have customers’ permission to use their fi les to train software.

To make it easier to improve Photoshop, Adobe added a Product Improvement 
pane to the Preferences dialog box in Photoshop. The purpose of the Photoshop 
Improvement Program is to request permission to use your images and usage data 
to help improve Photoshop features; this is not necessarily limited to machine learn-
ing. The “Yes, I’d like to participate” option is disabled by default, but if you want to 
participate, you can enable it. When it’s enabled, Adobe researchers may collect 
usage data, cloud documents, and other images you edit in Photoshop.

Whether or not you participate in the Photoshop Improvement Program is partly a 
personal decision. You may want to participate if you think your usage data might 
help improve how well Photoshop handles the kinds of image editing that you do.

However, if you work for a company or organization that handles confi dential 
documents, if you need to protect the privacy or proprietary data of your clients, or 
if you are legally bound by nondisclosure agreements, you should be aware of the 
potential consequences of participating in the Photoshop Improvement Program.

For more information about how your usage information is handled, see the Adobe 
Product Improvement Program web page at adobe.com/privacy/apip.html.

http://adobe.com/privacy/apip.html
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Review questions
1 How does a filter in Neural Filters differ from other filters in Photoshop?

2 How does an Internet connection affect how you use Neural Filters?

3 Why is it typically best to choose any Neural Filters output option except Current 
Layer?

4 How can Neural Filters help restore digitized images of old prints and slides?

5 How can Neural Filters help with compositing multiple images?

Review answers
1 Neural Filters are trained using machine learning, so they are capable of results that are 

not attainable using conventional algorithmic filters.

2 If you are connected to the Internet, you can download Neural Filters and use Neural 
Filters that process image data in the cloud. If you choose to participate in the 
Photoshop Improvement Program, an Internet connection allows your usage data and 
images to be sent to Adobe for use by researchers.

3 The Current Layer option applies the results of Neural Filters to the selected layer, 
permanently changing it (destructive editing). The other Output options apply the 
results of Neural Filters to a separate layer or as a Smart Filter, preserving a layer’s 
original state, so that you can start over at any time (nondestructive editing).

4 The Photo Restoration Neural Filters (and possibly Super Zoom) can help improve 
the quality of digitized images of old prints and slides. The Colorize Neural Filter can 
re-create colors for a black-and-white photo. JPEG Artifacts Removal can improve 
images that were saved at a low-quality JPEG compression setting. Depth Blur can help 
focus attention on the subject of a photo. 

5 Neural Filters such as Landscape Mixer, Harmonization, and Color Transfer can help 
unify a composite by making its layers more visually consistent with each other.
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sets  340
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Add Media button  272
Add Noise filter  241
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Curves  126–127
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Adobe After Effects  308
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Load Files into Photoshop Layers 

command  225
opening files in Camera Raw from  290
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previewing a file  134, 268

Adobe Camera Raw
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AI Denoise  321
Before/After Views button  291, 296
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Clone tool  312
Content-Aware Remove tool  312
Enhance command  321

file formats for saving changes  308
filmstrip  311
filter  317
gradient masks  322
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Open as Object button  305
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profiles  293
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saving files from  303–304
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Select Objects  322
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Select Sky  299, 322
Select Subject  299, 322
Super Resolution  321
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version  288
workspace  292

Adobe Capture  216
Adobe Creative Cloud

installing applications  3
mobile apps  216
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Adobe Creative Cloud desktop application  3, 7
Adobe DNG (Digital Negative) file format  290, 

307, 308, 309, 323
Adobe Firefly  40
Adobe Fonts  4, 26, 182, 193, 196
Adobe Generator  346
Adobe Illustrator  202, 308
Adobe InDesign  185, 308
Adobe Lightroom  11
Adobe Lightroom Classic  306–307
Adobe PDF (Portable Document Format)

Photoshop PDF format  193
printing on press  360
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Adobe Photoshop
installing  3
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resetting default preferences  10
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2024 Release

about  1
lesson files and Web Edition  5
prerequisites  2

Adobe Portfolio  378–380
Adobe PostScript  360
Adobe Raw profile  293
Adobe Stock  12

designing with  120
Libraries panel import  103
licensing  120
Search Adobe Stock command  94

AI Denoise, in Adobe Camera Raw  321
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anchor points  203, 206
animating

Pan & Zoom effect  279
position  275
text  275–278

animation, frame  282
anti-aliasing  76
applying an edit  15
arrow keys, nudging with  75–76
artboards

about  346
adding  348
duplicating  346
exporting  354
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resizing  351

Artboard tool  348, 351
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adding  273
fading  274
muting  274–275
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Auto-Align Layers  146
automating tasks  340–346
Auto-Select option  116
AVIF file format  308, 309

B
background layer

about  90, 92
converting to a regular layer  92, 342
erasing  95

background, removing  157
barrel distortion, correcting  141
batch processing. See actions
bitmap images

overview  10
vector graphics vs.  200–201

black and white, converting color images
in Adobe Camera Raw  293
in Photoshop  62

black point  297
Black & White adjustment layer  62
Blend Images Together option  135
blending modes

applying to layers  99
deciding which to use  100
definition  98
previewing  99, 100

Bloat tool in the Liquify filter  233
blog, Photoshop tips and info  7
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Field Blur  132
Iris Blur  130–131, 132, 238
Path Blur  132, 133
restore noise  133
Spin Blur  132
Tilt-Shift  132

Blur Effects panel  133
Blur Gallery  130–133
borders, adding  95, 116
Bridge. See Adobe Bridge
brightening an image  126–127, 136
Brightness/Contrast adjustment 

layer  238
bristle tips, for brushes  248
Browse In Bridge command  44
brushes

loading with color  253
presets. See brush presets
rotation angle  257
settings  249

Brushes panel  255
brush presets

exporting  256
loading  255–258
painting with  258–260
Brush Settings panel  249

Brush tool
about  32
Paint Symmetry  261

buttons, as web graphics
creating  327–346
duplicating  335

C
calibration, monitor  366
Calibration panel, in Adobe Camera 

Raw  299
Camera Raw. See Adobe Camera Raw
Canvas Size command  342
center, selecting from  80
Channel Mixer adjustment layer  238
channels. See color channels
Character panel  105, 195
character styles  185
checkerboard transparency indicator  95
chromatic aberration  141
Clarity, in Adobe Camera Raw  311, 317
Classroom in a Book. See Adobe 

Photoshop Classroom in a Book 
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Clean Brush After Every Stroke  
icon  252

Clean Brush option  253
clipping masks

about  157, 179
creating  115, 182–184, 363
indicator  183
shortcut  183

Clone Stamp tool  60
closing a Photoshop file  12
Cloud Documents

about  67
opening  11, 68
saving  68

Clouds filter  103
CMYK color mode, converting to  368
CMYK color model  366, 367
collaborating

libraries and  216
sharing an image  16

color
additive  367
adjusting overall  51
changing foreground  31
channels. See color channels
converting to black and white  62
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color (continued)
default text  182
fonts  195
foreground and background  31
management. See color management
mixing with the Mixer Brush  252
out-of-gamut  368
previewing gamut clipping  368
sampling  31, 249
softening edge transitions  76

Color blending mode  100, 234
Color Burn blending mode  100
color casts, removing  51
color channels  157, 290, 364, 373–375
Color Dodge blending mode  100
color gamut. See gamut
Color Grading panel, in Adobe Camera 

Raw  299
Colorize Neural Filter  387
color management  366–369, 367, 376
Color Mixer panel, in Adobe Camera 

Raw  299
color profile. See profiles, color
Color Range command  84, 318
color samplers, in Adobe Camera 

Raw  291
color separations  374
Color Settings dialog box  367–368
color settings, saving and restoring  6
color space  366
combining images

using Adobe Bridge  225
by dragging layers  93–96
into an HDR merge  309
into a panorama  134–137, 309
using Place Embedded/Linked 

commands  14
with different perspectives  147–151

Commit button  86, 101
committing (applying) an edit  15
compositing. See combining images
Content Authenticity Initiative  40
Content-Aware Crop  138
Content-Aware Fill for panoramas  135
Content-Aware Move tool  60, 152
Content-Aware Remove tool, in Adobe 

Camera Raw  312
Content Credentials  40
Content panel, in Bridge  45
context menus  91, 98, 119, 184, 193
Contextual Task Bar  15

Contrast slider in Camera Raw  297
Control Timeline Magnification 

slider  272
Copy command  93
copying

anti-aliasing edges  76
commands  83
images  119, 371
layers  93, 93–95
selected pixels  82, 83
settings in Camera Raw  302

Copy Merged command  83
corner points  203
Create Video Animation  282
Create Video Timeline  270
Creative Cloud. See Adobe 

Creative Cloud
Crop and Straighten Photos 

command  53
Crop tool  47–50, 86–87

in Adobe Camera Raw  291
clearing settings  50
crop shield  50
leveling  50

Cross Fade transition  280
Curvature Pen tool  201, 202, 205
curved paths  203
Curve panel, in Adobe Camera Raw  299
Curves adjustment layer  51, 126

D
Darken blending mode  100
Darker Color blending mode  100
Decontaminate Colors option  167
defaults

in Adobe Camera Raw  321
resetting Photoshop  5, 10

Define Custom Shape command  217
Define Pattern command  173
Delete Cropped Pixels option  50
deleting documents

from Adobe Camera Raw  291
from Cloud Documents  69

depth map  131
depth of field, extending  144
Deselect command  72
Detail panel, in Adobe Camera Raw  300
Difference blending mode  100
Difference Clouds filter  237
Direct Selection tool  203, 211
Discover panel  6

discretionary ligatures  195
distortions, correcting  147
DNG. See Adobe DNG (Digital Negative) 

file format
docking panels  30
document size, displaying  16, 118
document window

fitting image to  81
scrolling  20
Status Bar  18

dots per inch (dpi)  49
drag-and-drop importing  103
Drop Shadow layer style  337, 342
drop shadows  110–111, 112
duplicating

buttons  335–339
images  119, 371
layers  335

duration of video clips, changing  274

E
educators, resources for  7
Elliptical Marquee tool

centering selection  80
circular selection  74
in Tools panel  66

emoji fonts  195
Enhance command, in Adobe Camera 

Raw  321
Enhance Edge option  71
enlargement  394
Exclusion blending mode  100
Expand command  73
Export As command  354, 355
exporting

Adobe Camera Raw edited version  
290, 303–309, 321

artboards  354
brushes  256
layers as separate files  355
video  281

Exposure adjustment layer  239
Extras command  76
Eyedropper tool  31, 32, 249
eye icon, in the Layers panel  91

F
face adjustments

with healing tools  312
with Liquify filter  128, 228
with Smart Portrait filter  394
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Face-Aware Liquify filter  128
fading audio  274
Farrer, Lisa  408
Faulkner, Andrew  264
Feather command  76
feathering  76
Field Blur  132
file formats. See name of format
file size  49
fills

foreground color  117
gradient  106
pattern  173
shape layer  201

filmstrip, Adobe Camera Raw  291
filtering lists

filmstrip in Camera Raw  291
Layers panel  99

filters  393
adding clouds with  102
Add Noise  241
Adobe Camera Raw  317
Difference Clouds  237
Liquify  228–229
Neural Filters  384
Smart Filters. See Smart Filters
Smart Sharpen  61, 341
where to find different  393

Find. See Search command
Fit On Screen command  81

Hand tool shortcut  80
Flatten Image command. See flattening
flattening  52, 118, 360
fonts

alternates  195
changing in the options bar  26
color  195
emoji  195
Font Similarity  193
formats  178
installing  4
OpenType  195
PostScript  195
previewing in context  181
selecting  180
special characters  194
variable  195

Font Similarity option  193
Foreground and Background 

colors  31, 108
forum, Photoshop community  7

four-color printing (CMYK)  367
fractions  195
frames  327
Frame tool  327
Freeform Pen tool  201
freehand selections  77–78
Free Transform command  226, 228

moving with  231
options bar settings  349
resizing with  101
rotating with  187

Free Transform Path command  171

G
gamut, color

colors outside of  368–369
defined  366

Gamut Warning  368–369
Generative Credits  40
Generative Expand  138
Generative Fill  36–38, 40, 57–59
Generator. See Adobe Generator
GIF animation  282
GIF format  90, 282, 346
Global Light option  110
Glyphs panel  194, 195
Go To First Frame button  273
GPU. See graphics hardware
GPU acceleration  3
gradients

editing  109
listing by name  107
masks in Adobe Camera Raw  322

Gradients panel  108
Gradient tool  108
Graham, Jay  306, 408
graphics hardware  3
grid

in Adobe Camera Raw  291
in Lens Correction filter  142

guides
adding  179
ruler  332
Smart Guides  220

H
Hand tool  80
Hard Light blending mode  100
Hard Mix blending mode  100
Harmonization Neural Filter  391

HDR, in Adobe Camera Raw
HDR editing  303, 308, 309
HDR merge  309

Healing Brush tool  56, 60
Heal tool, in Adobe Camera Raw  

291, 312
HEIF format  131
Help, Photoshop  7
hiding

layers  94
selection edges  76–77

HiDPI  49, 356
histogram

Camera Raw  291, 300
in Curves and Levels adjustment 

layers  52, 365
History panel  237–242
Home screen  11
Horizontal Type tool  26, 105, 180
hue, adjusting for printing  371
Hue blending mode  100
Hue/Saturation adjustment layers  212

I
Illustrator. See Adobe Illustrator
importing. See also Place Embedded 

command, Place Linked command
audio  273
embedded Smart Objects  345
multiple files from Bridge  225

InDesign. See Adobe InDesign
Info panel  327, 332
inkjet printers  376
Inner Shadow layer style  183
installing the software  3
integrated graphics  3
interface. See user interface
International Color Consortium 

(ICC)  366
iPad, Apple  67
iPhone, designing for  348
Iris Blur  130–131, 132, 238
Isolate Layers command  99

J
JPEG Artifacts Removal Neural 

Filter  395
JPEG file format

Camera Raw and  290, 303, 308
compared to other formats  308
compression artifacts  395
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JPEG file format (continued)
Export As  354
image quality degradation  307
type quality  193
web design  346

JPEG XL file format  308, 309

K
Kent, Lynette  264
keyboard shortcuts

customizing  254
duplicating  82

keyframes
animating with  275
appearance of  275
moving to the next or previous  276

Kost, Julieanne  7, 162, 184, 201, 254, 408

L
Landscape Mixer Neural Filter  390
Large Document Format  308
Lasso tools  66, 77–78
layer comps  118
layer effects

adding  110–115
updating  116

layers
about  90
adding  102–103
Background  92
blending modes  98–99
converting Background  92, 342
copying  93–95
copying and centering  93, 97
copying and merging  83
copying and pasting  93
copying to other  93
duplicating  98, 335
effects. See layer effects; See 

also layer styles
exporting individually  355
flattening  118, 119
generating images from  346
groups  332
hiding and showing  91, 94, 95
linking  101–103
locking  91
masks  157
merging visible  118
opacity  98
overview  90

painting  234
rearranging  96–98
renaming  93
resizing  101–103
rotating  101
saving in GIF or JPEG formats  90
showing and hiding  94
styles. See layer styles
thumbnail icons  91
transforming  101
transparency  98–99
type  105

Layers panel
filtering  99
overview  91–92

layer styles  393
adding to type  183
applying  106–109, 110–113
in Creative Cloud Libraries  111
Drop Shadow  110, 113, 337, 342
overview  106, 110
presets  219
Satin  113
Stroke  112, 338

leading  192
learning resources for Adobe 

Photoshop  6
Learn tutorials  12
Lee, Megan  262
Lens Correction filter  141–143
lens flaws, correcting  141–143
lesson files, accessing  5
Levels adjustment layers  52–53, 136
Libraries, Creative Cloud

Adobe Stock  103
color swatches  103
images  103
layer styles  111
linked Smart Objects  216
mobile apps  216

Libraries panel  120
licensing, Adobe Stock  120
ligatures  195
Lighten blending mode  100
lightening an image  126–127, 136
Lighter Color blending mode  100
Light panel, in Adobe Camera Raw  297
Lightroom. See Adobe Lightroom Classic
Lightroom photos online storage  41
Linear Burn blending mode  100
Linear Dodge blending mode  100

linear gradients  102–104
Linear Light blending mode  100
Liquify, Face-Aware filter  128
Liquify filter  228–229
Load Files Into Photoshop Layers 

command  225
low resolution images, upscaling  

243, 394
luminance mask  84, 322
Luminosity blending mode  100

M
machine learning  57, 66, 84, 159, 196, 

243, 297, 321, 322, 384, 396
macros. See actions
Magic Wand tool  66, 70–71
Magnetic Lasso tool  66, 79–80
magnification. See Zoom tool

document  18–20
Timeline panel  272

magnifying glass. See Zoom tool
mandalas, painting  261
marching ants. See selection marquee
marquee tools  66
masks  156

in Adobe Camera Raw  299, 314
channel  157
creating  157–160
luminance  84
overview  156
refining  162–167
compared to selections  156
terminology  157
vector  157

Match Font command  196
megapixels  48
memory (hardware)  3
Merge Visible command  119
merging

images  144
images into a panorama  134
images with different 

perspectives  147–151
layers  118

mistakes, correcting  34–41
Mixer Brush tool

about  248
cleaning the brush  253

mixing colors
with a photograph  255
with Mixer Brush tool  252
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mobile devices
designing for, with artboards  349
using with libraries  216

monitor calibration  366
More Image Settings button in Adobe 

Camera Raw
  321

motion blur effects  133
Motion panel  279
Move tool

Auto-Select option  116
moving selections  72
scissors icon  81

moving
layers. See Move tool
panels  30
selections  72–73

Multiply blending mode  100
muting audio  274–275

N
navigating

in Adobe Camera Raw  291
keyboard shortcuts  362
using the Navigator panel  20

Navigator panel  20
Neural Filters  129, 384, 393

compared to other filters  393
downloading filters  386
Output options  389
previewing changes  386
using  385

nondestructive filters  228
notes. See Note tool

deleting  193
Notes panel  191

Note tool  191
nudging layers  353
nudging selected pixels  75

O
Object Selection tool  73–74, 120
on-image adjustment tool. See targeted 

adjustment tool
opacity, changing  98–99
opening images in Camera Raw  290
Open Object button (in Camera 

Raw)  305
OpenType font format  178, 195
OpenType SVG  195

options bar  15
reference point icon  349
setting type options in  26

organizing photos  306–307
out-of-gamut color  368–369
output options, Neural Filters  389
output resolution, determining  49
Overlay blending mode  99, 100

P
painting

layers  234
wetness options  250
with the Mixer Brush tool  246–260

painting gallery  262
Paint Symmetry option  261
panels

adding to another group  30
defined  15
docking  30
floating  30–31
resizing  30
undocking  30

panning with the Navigator panel  20
panoramas

in Adobe Camera Raw  309
in Photoshop  134–137

Pan & Zoom option  279
Paper Color option  370
paper, simulating white  370
paper size, print  376
paragraph styles  185
paragraph type  180
Paste command  93
Paste in Place command  83
Paste Into command  83, 244
Paste Outside command  83
Paste Profile Mismatch dialog box  242
Paste Without Formatting 

command  83, 191
pasting layers  93
Patch tool  60
Path Blur  132–133, 133
paths

about  201
adding type to  185–186
closing  203
compared to shapes  209
converting to/from selection  212
drawing  202–207
drawing curved segments  203

drawing straight segments  203
editing  211
moving  211
saving  203
work path  203

Path Selection tool  211
Paths panel  204
patterns

Pattern command  173
Pattern Preview command  171
Patterns panel  219

patterns, creating  170
Pavlov, Victoria  263
PDF. See Photoshop PDF file format
Pen tool. See also paths

drawing paths  202–206
keyboard shortcut  201
overview  201–202, 203
as selection tool  202
setting options  204–205

people masks, in Adobe Camera 
Raw  318

Perspective Warp command  147
Photomerge  134–137
photo restoration, manual  54–55
Photo Restoration Neural Filter  386
Photoshop PDF file format  193, 308, 375
Photoshop Raw format (not camera raw 

format)  308
pincushion distortion  141
Pin Light blending mode  100
pixel dimensions  48
pixels

compared to vector graphics  200
defined  10
path tools option  209
resolution and  48

pixels per inch  48
Placed Linked command  328
Place Embedded command  182, 

345, 346
placeholders  327
PNG (Portable Network Graphics) file 

format  308, 346
Point Color panel, in Adobe Camera 

Raw  299
point type

defined  180
distorting  188–189

Polygonal Lasso tool  66
Polygon tool  170
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portfolio. See Adobe Portfolio
position, animating in video  275
PostScript fonts  195
ppi (pixels per inch)  48
preferences

Adobe Camera Raw  291
Export  355
gamut-warning color  369
History States  242
opening  22
Product Improvement  40, 396
restoring defaults  5, 10
searching  22
Units & Rulers  22, 327

Preserve Details (Enlargement) 
option  243

Preserve Numbers option  370
presets

in Adobe Camera Raw  291, 294, 321
artboard  348
brush  255–258
Curves panel  126
Gradients panel  108
overview  35–36
shapes  215
Styles panel  219

previewing
colors for printing  369
edits in dialog boxes  61
files in Adobe Bridge  45
fonts in context  181

printing
CMYK model and  366–367
on a desktop printer  376
for press  359–381
identifying out-of-gamut 

color  368–369
for inkjet printers  376
preparing images for  360
proofing images onscreen  369–372

printing inks, simulating onscreen  370
privacy  396
process colors  367
profiles, Adobe Raw  293, 310
profiles, color

CMYK  374
display (monitor)  366
ICC  366
printer  370

proofing images  369–372

Properties panel  15–16, 108
artboard editing  348
clipping masks  363
Curves adjustment  51
targeted adjustment tool  62
type settings  181

proxy icon  349
PSB (Large Document Format)  308
PSD (Photoshop) format  290, 308
public domain  40
Pucker tool in the Liquify filter  233
Puppet Warp command  168

Q
Quick Mask mode  84, 157
Quick Selection tool  66, 71, 159

R
radial symmetry  261
RAM. See memory (hardware)
range masks, in Adobe Camera Raw  322
raster images, overview  200
rate images, in Adobe Camera Raw  291
Raw Details, in Adobe Camera Raw  321
raw profiles  299
recording actions  340–344
Rectangular Marquee tool  66, 333
red eye, correcting  124–126
Red Eye Removal, Adobe Camera 

Raw  291
Red Eye tool  125–126
Redo command  34
reference point  349
Refine Edge. See Select and Mask
Refine Edge Brush tool  162
Remove tool  40, 53–54, 60
rendering video  281
repositioning selections  74
resampling  47
Reselect command  75
Reset, in Adobe Camera Raw  321
resizing. See also scaling

from center  231
layers  101
panels  30
proportionally  82

resolution
about  48–49
Adobe Stock images  94, 120
best practices  307

bitmap images vs. vector 
graphics  200

Camera Raw  292, 304
Crop tool option  47
increasing  243
professional printing  360, 362
screens of high and low  346, 356
text  197

resolution, Retina/HiDPI scale 
factors  356

responsive design  347
Retina resolution  49, 356
retouching a portrait, in Adobe Camera 

Raw  310
retouching/repairing

removing blemishes  53–54
with the Remove tool  53

Return To Adobe Photoshop 
command  130

RGB color model  366, 367
rotating

constraining  78
layers  101
paths  187
in Puppet Warp  169
selections  78
stylus  257

rounded corners, creating  172
ruler guides  179, 332
rulers  22, 180

S
sampling colors  31, 249
Satin layer style  113
Saturation blending mode  100
saturation in Camera Raw  297
Save for Web (Legacy) command  346. 

See also Export As command
saving documents. See also exporting

as Cloud Documents  68
flattening and  118–121
as Photoshop PDF format  193
as Photoshop PDF  375

Scale to Fit Media print option  377
scaling

animating  277
using Crop tool  50
document (Image Size command)  48
using Free Transform command  101
in Lens Correction filter  142
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low resolution image  243
pattern fills  174
when printing  377
proportionally  82
raster (bitmap) images vs. vector 

graphics  200
using Scale command  82
in Sky Replacement  140
using Free Transform command  349

Screen blending mode  100
screening, print  374
scrubbing numeric values  27
Search command  6
search icon  16
Search icon  11, 12
searching

Adobe Stock  120
Preferences  22
within Photoshop  11

Select and Mask command  157
selecting. See also selections

about  66
adding to selection  72
center point, from  80–81
by color  66
creating from a path  212
high-contrast edges  79–80
intersecting with existing  72
modifier keys  72, 75
new selection  72
non-transparent pixels  84
skin tones  318
a subject automatically  159
subtracting from  72
text  116

selection marquee  76
selections. See also selecting

circular  81
converting between pixels and 

paths  85, 212
copying  83
duplicating  82
elliptical  73–81
feathering  76
freehand  66
geometric  66
hiding edges of  76
in Adobe Camera Raw  322
moving  72–73, 75, 81–82, 82
rotating  78–79

showing edges of  76
softening  76

selection tools  66–67
separations. See color separations
shapes

creating your own  217
defined  209
editing  217
presets  213–216

Share button  16
Share for Review command  191
sharpening

in Adobe Camera Raw  300–301
in Adobe Photoshop  61

sholby (artist)  263
shortcuts. See keyboard shortcuts
shortening video clips  274
Show/Hide Visibility column  95
side by side documents  93
sidecar XMP files  302
Single Column Marquee tool  66
Single Row Marquee tool  66
Skin Smoothing Neural Filter  394
skin tones, selecting  318
Sky Replacement command  140
Smart Filters  130, 149, 228–231, 233, 

245, 389
Smart Guides  28, 82, 217, 220, 227
Smart Objects

converting layers to  228
editing  131, 230
embedded  345
icon badge  228
linked  216
Smart Filters and  228

Smart Portrait Neural Filter  394
Smart Sharpen filter  61, 341
smooth points  203
snapshots, in Adobe Camera Raw  

291, 321
Soft Light blending mode  100
soft-proofing  369–372
sort, in Camera Raw  291
special characters  194
spell checking  184
Spin Blur  132
Spot Healing Brush tool  60
stacking order, changing  96–98
star, creating a  170
starting Photoshop  10

Status Bar  16, 18
Stop Recording button  344
stopwatch icon in Timeline panel  275
Straighten button  47, 138
strobe effect  133
Stroke layer style  112, 338
strokes  201
Structure option  152
Styles panel  219
Style Transfer  395
Super Resolution, in Adobe Camera 

Raw  321
Super Zoom Neural Filter  394
SVG (Scalable Vector Graphics) file 

format  195
swashes  195
symmetry, painting with  261
synchronizing Camera Raw settings  302
system requirements  3

T
tablet, graphics  249
tabs, document  15
targeted adjustment tool  62
teachers, resources for  7
temperature, image color  294
text. See also type

adding  180
applying edits  181
centering  105
creating  26, 105–106
default color  182
moving  106
selecting  116, 181

Texture, in Adobe Camera Raw  311, 
317, 319

thumbnail icons, layer  91
TIFF (Tagged Image File Format)

camera raw images and  290–291, 308
compared to other formats  307, 308
type quality  193

Tilt-Shift Blur  132
timeline, creating  270
Timeline panel  269

changing the magnification  272
returning to the first frame  273

Tint
in Black & White adjustment 

layers  62
in white balance (Camera Raw)  294
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Toggle Last State command  237
Toggle Reference Point option  349
Tolerance option for Magic Wand 

tool  70
tone, adjusting  51–52
tools

Brush tool  32
Clone Stamp tool  60
Content-Aware Move  152
Content-Aware Move tool  60
Crop tool  47
Elliptical Marquee  244
Eyedropper  31, 249
Healing Brush tool  56, 60
Horizontal Type tool  26
keyboard shortcuts  201
Lasso tool  77
Magic Wand tool  70, 73
Magnetic Lasso tool  77, 79
Object Selection tool  58, 66, 73
Patch tool  60
Polygonal Lasso tool  77
Quick Selection tool  71, 159
Rectangle tool  333
Remove tool  53, 60
selection  66–67
Spot Healing Brush tool  60
using  17–23

Tools panel. See also tools
selecting and using tools from  18–24

tool tips, displaying  18
tracing a photo  208
tracks, in a timeline  270
transforming  101. See also Free 

Transform command
Transform Selection command  74
transitions, video  280
transparency

adjusting  98–99
blending modes and  100
recognizing (checkerboard)  95

Transparency & Gamut preference  369
TrueType fonts  195
tutorials built into Photoshop  11
type. See also text

aligning  180
clipping mask  179, 182–184
creating  180–181
on a path  185–186
overview  178
resizing  178

setting options  180
swashes  195
tricks  184
true fractions  195
warping  188–189

typefaces. See fonts
Typekit. See Adobe Fonts
type layers

creating new  105, 184
selecting contents  184

Type tool  26–27

U
undocking panels  30
undoing steps

with commands  34–35
with the History panel  237–242

unit of measure  22
Units & Rulers command  22
Units & Rulers preferences  327
upscaling images  243, 394
Use Global Light command  110
user interface

Adobe Camera Raw  292
overview  10–12

V
Variable Fonts  195
vector graphics

bitmap images vs.  200
defined  10
overview  200

vector masks  157
version, Photoshop  2
Vibrance, in Adobe Camera Raw

  297
video

adding audio to  273
adding pan and zoom 

effects  279–280
adding transitions  280–281
clip duration, changing  274
exporting  281
groups  273
overview  268
rendering  281

video card. See graphics hardware
vignetting  141
visibility icon. See eye icon
Vivid Light blending mode  100

W
warping

images with the Liquify filter  228
perspective  147–151
Puppet Warp  168–169
type  188–195

watermark, Adobe Stock  120
Weaver, Gawain  54, 408
web assets, exporting from layers  355
web design

HiDPI  356
responsive  347
Retina  356
workflow  324

Web Edition  5
Webster, Kyle T.  261
wetness options, in painting  250
White Balance tool (in Camera 

Raw)  294–296
white point  297
White Point eyedropper tool  364
work area  10–41
workflow preferences, Adobe Camera 

Raw  291
workflows

color-managed  367–369
compositing  90
frame animation  282
prepress  360
professional photography  306–307
video  266
web design  325

work path  203
workspaces

Graphics and Web  179
Painting  249
Workspaces menu  16

Workspaces menu  16

X
XMP files  302

Y
YouTube  281

Z
Zoom option in video  279
Zoom tool. See also magnification

in Adobe Camera Raw  291
shortcuts  162
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